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INCLINEO®

A user’s handbook

Dear Customer,

This handbook sets out to help the instrument user work through the instrument
with the required ease. It is meant to be a quick learning tool that hopefully should
not only make compelling reading but also provide useful guidance when employing
INCLINEQ®, the high precision electronic inclinometer.

PRUFTECHNIK Alignment Systems GmbH
Freisinger Str. 34
85737 Ismaning

Germany
Fax +49.89.99616-100
Email info@pruftechnik.com

Edition August 2012
Order number ALl 9.183.G
Firmware version 2.0x

INCLINEQ® is a registered trademark of PRUFTECHNIK Dieter Busch AG. PRUFTECHNIK
products are the subject of patents granted and pending throughout the world.
Contents subject to change without further notice, particularly in the interest of
further technical development. Reproduction, in any form whatsoever, only upon
express written consent of PRUFTECHNIK Alignment Systems GmbH.

© Copyright 2009 by PRUFTECHNIK Alignment Systems GmbH
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Foreword

INCLINEQ®is yet another innovative product introduced to the market by PRUFTECHNIK.
It combines functions which until now were not available in one compact system
with an elegant design and simplicity of use. Its ergonomic design functionality in
operation together with manufacture from materials that are extremely light but
able to withstand harsh operating environments makes INCLINEO® a highly accurate
and easy to use measurement system. In operation the unit is able to be rotated
through 360° making measurement at any angular position possible. It is operated
using just 3 keys with a functional menu that offers the user all the required options
for measuring profiles and determining levelness and parallelism of surfaces. The
integrated Bluetooth wireless technology is used to transfer data via a flexible modern
common PC software platform for processing and display. INCLINEO® is appropriate
for the following applications:

Measurement on surfaces with any inclination
Level, flatness or parallelism of surfaces

Angularity measurements along edges and borders
Plumbness of vertical shafts

Parallelism of sloping surfaces

Perpendicularity of planes

v v v v v v ¥

Ideal for installation and service
INCLINEQ® is a suitable tool for most production industries.

If you have any suggestions for improvement or corrections (not just to this manual,
but also for hardware), please drop us a line. We would be glad to make improve-
ments wherever possible.

We look forward to hearing from you.

PRUFTECHNIK Alignment Systems
Ismaning, Germany
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INCLINEO packages

INCLINEO standard package ALI 18.000

The standard INCLINEO package ALl 18.000 constitutes the listed items:

ALl 18.201 INCLINEO inclinometer assembly without base

ALl 13.620 USB RF dongle

ALl 18.500 Three point mounting base

ALI 18.501-150 INCLINEO grooved mounting base for smooth
surfaces

ALl 18.502-150 INCLINEO prism-shaped mounting base for rolls
and shafts

ALl 18.200 comprises
ALI 18.201 and
ALl 18.500

ALl 13.620

e

dh‘ PRUFTECHNIK

4 +0.0014

deg-ABS Filter: min
INCLINEO

T
O MENS OLD.
>

ALl 18.502-150
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0 0621 0038 Philips cross screwdriver
00739 1056 Allen key (3.0 mm) 006210038
90022 (4 no.) Standard AA size batteries
ALl 18.800 INCLINEO standard case
ALl 13.700 CD ALIGNMENT CENTER CD
ALl 9.182.G INCLINEO pocket guide
ALl 9.183.G INCLINEO operating instructions
ALI9.182.G

ALI9.183.G i

00739 1056

90022

ALl 13.700 CD ALl 18.800
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Other INCLINEO packages

Other INCLINEO packages are listed below and details of their composition may be
obtained from your local PRUFTECHNIK Alignment Systems representative.

INCLINEO package with grooved mounting base (150 mm) ALI 18.001
INCLINEO package with prism-shaped mounting base (150 mm) ALl 18.002
INCLINEO package with three-point mounting base ALl 18.003

Optional INCLINEO components

ALl 18.290 INCLINEO calibration certificate
ALl 18.400 INCLINEO USB converter

ALl 18.500-M INCLINEO magnetic foot

ALl 3.581-2 Receiver cable

ALl 18.400

ALl 18.500-M
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Safety notes

Intended use

INCLINEO is a package designed to be used in industrial environments only for
measuring inclination and angularity on surfaces, rolls and shafts. Care must be taken
to ensure that the system is not subjected to mechanical knocks. INCLINEO must
be operated only by properly trained personnel. No liability will be assumed when
components or operating procedures as described in this manual are altered without

permission of the manufacturer.

Safety symbols

The following symbols are used in this manual in order to draw the reader’s attention
to especially important text, such as that regarding possible sources of danger or
useful operating tips.

This symbol denotes general information and tips regarding operation of @

INCLINEO. Note

This symbol denotes information which must be followed in order to avoid A
damage to equipment.

CAUTION
This symbol denotes information which must be followed in order to avoid
personal injury.

WARNING
The number within the red circle corresponds to the instruction with the same o

number and must be followed exactly.

CE compliance and EMC
All INCLINEO components fulfil the EC Guidelines for electric devices and those
relating to electromagnetic compatibility (2004/108/EC).

IP classification
INCLINEO and related components are water and dust resistant (IP65). (dust-tight and
protected against immersion).
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Storage

When not in use, store INCLINEO in such a manner that the display lies in parallel
with the red handle and the mounting base. Also ensure that the display axis remains
horizontal within +/- 5°. INCLINEO should be stored at temperatures between 15°
and 30° C. These measures should prevent against premature damage of the high
precision electronic inclinometer.

Note regarding data storage

With any data processing software, data may be lost or altered under certain @

circumstances. PRUFTECHNIK strongly recommends that you keep a backup or
printed records of all important data.

PRUFTECHNIK assumes no responsibility for data lost or altered as a result of
improper use, repairs, defects, battery replacement/failures or any other cause.

PRUFTECHNIK assumes no responsibility, directly or indirectly, for financial losses
or claims from third parties resulting from the use of this product and any of its
functions, such as loss or alteration of stored data.

Service and care

Although INCLINEO is essentially maintenance free, the calibration accuracy of the
system should be checked every six months as indicated by the calibration label (see
below) located on the back of the rotatable inclinometer assembly.

Component labelling
The labels shown below are to be found on INCLINEO.

=y Type
r
o S. No.
—

@
a
&
-2
()
s
&
5
=

HW _
C € www.pruftechnik.com

The above label is affixed on the The calibration label is affixed
back of INCLINEO and shows on the back of INCLINEO and
the part and serial number of shows the date of the next
the system and the hardware scheduled calibration.

version.

Note
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Getting to know INCLINEO, the high precision inclinometer

Important parts of INCLINEO

Rubber grip handle

Micrometer screw
for fine adjustment

Battery status LED

O ‘\ _
. 4 +0.0

deg-ABS. rmer min
INCLINEO
—

s

indicator

|— Bluetooth LED

indicator
Display

Rotatable inclinometer
assembly

Operating keys

Measurement base

External
interfaces

Labeling

ON/OFF
switch

Locking screw

Inclinometer
assembly -
locking lever | |

11
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Description of INCLINEO parts

>

Rubber grip handle — To improve flexibility for measurement, the handle may
be detached from the assembly and rotated through 180°. This is readily
achieved by undoing the two hex socket screws on the base of the handle.
The socket screws are loosened or fastened using the provided 3 mm allen
key.

Micrometer screw gauge — Used for fine adjustment during the set-up
procedure. It is recommended to try and have the red marking on the screw
gauge positioned in the middle of the slot.

Battery status LED indicator — This constitutes 3 LED bars to indicate the
INCLINEO battery capacity.

The 3 LED bars operate as a graph to indicate the battery capacity from 100%

where all three are lit continuously to low capacity of under 25% where only a
single LED bar blinks fast. In this case, the battery operating time is in a critical
phase and measurements should not be take.

Note

The operating time may vary significantly depending on the type of batteries
used. Normally, alkaline AA-size batteries are used.

Bluetooth LED indicator — Used to indicate whether the system’s wireless
communication is on or off. When wireless communication is turned on, the
Bluetooth LED bar blinks slowly.

Display — All set-up, measurement and menu items are shown on the display.
The display’s backlight may be turned on to illuminate the screen.

Rotatable inclinometer assembly — The assembly houses the high precision
inclinometer. By being rotatable, it provides the flexibility to measure virtually
any inclination.

Operating keys — The operating keys are used for a variety of functions which
include: calling up and cycling through menu items, turning the display
backlight on or off, freezing any indicated value.

Measurement base — The measurement base is changeable to suit the type of
surface being measured. Three different types of bases are available.

External interfaces — Three ports for direct connection to a PC or a sensor or
a measurement gauge are available on the back of INCLINEO. Presently, the
sensor and measurement gauge ports are dedicated to marine applications.
Battery compartment — The compartment is opened using a Phillips screw
driver. Remove the compartment to replace the 2 AA-size batteries.
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> The on/off switch is part of the battery compartment.

> Labelling — Two labels are affixed to the back of INCLINEO. One shows the
date when calibration is due and the other shows the article number, the
INCLINEO serial number and the version of the hardware.

> Inclinometer assembly locking lever — The lever is used to fasten the rotatable
assembly. The assembly is rotated only when the lever is loose. To lock the
assembly, the lever is turned to the left (as viewed from the side) with a small
amount of force. When the lever is in the “lock” position, the micrometer
screw gauge must never be turned.

Powering INCLINEO

INCLINEO is powered using 2 standard AA size alkaline batteries contained in the
battery compartment. It is recommended that both batteries be replaced at the same
time when only a single battery status LED bar blinks quickly.

Replacing batteries

Undo the two Phillips screws. With the screws loosened, hold and pull out the battery
compartment. The reverse procedure is used to reinstall the battery compartment.
Note the battery polarity when inserting them in the compartment.

13
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Understanding menu items

Always remember that the INCLINEO on/off switch is located on the back of the @
system.
Note
After turning INCLINEO on, the software version number appears on the display
followed by a value displaying the inclination in which the inclinometer finds itself in
the current state. The value is a relative measurement denoted by “REL".

« +0.1481

dea - EEL Filter:min

Press i to reveal available INCLINEO menu items. Use [B or B to cycle through the
main INCLINEO menu items. The following menu items are available:

Relative measurement

Absolute measurement

Filter

Units

Memory

Backlight

RF module

v v v v v v v v

Device info

Relative measurement

This is the first menu item that appears.

= Relative Meas =
+000.0000 deg

Pressing [ while in “Relative Meas” reveals the submenu items. Use [E or B to cycle
through the available submenu items. Press i to confirm selection of the currently
displayed submenu item.

Relative Meas Used to show the true inclina-
= rEEEt o tion of the inclinometer
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Used to set the displayed value

to zero

Used to edit the angular offset

value

Used to exit the “Relative

Meas” menu

The "Relative measurement” menu is exited by pressing with “exit” displayed.
The next menu item is accessed by pressing il to display the first menu item (Relative
Meas), followed by .

Absolute measurement
This is the next menu item that appears after pressing [E.

This menu item is used to set the absolute measurement mode. Readings taken after
this mode has been activated are absolute inclination values.

Type of filter
Pressing [l while in “Filter” reveals the submenu items. Use [& or [ to cycle through

the available submenu items. Press [iffl to confirm selection of the currently displayed
submenu item.

When selected, readings acquire

an average smoothing

When selected, maximum

smoothing is applied to the

readings

15
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When selected, the filtering
process is turned off and no
smoothing is applied to the

reading

When selected, minimum
smoothing is applied to the

readings

Used to exit the “Filter” menu

The “Filter” menu is exited by pressing & with “exit” displayed. The next menu item

is accessed by pressing i to display the first menu item (Relative Meas), followed by

or [ repeatedly.

Measurement units

This menu item is used to select desired measurement unit.

Pressing [ while in “Unit” reveals the submenu items. Use [E or B to cycle through

the available submenu items. Press il to confirm selection of the currently displayed

submenu item.

Used to select the measurement unit “arcsecond”.
1 arcsecond = 1" = 1/60 of an arcminute = 1/3600 of

a degree

Used to select the measurement unit “rel” which is
based on the relative base length of the given surface.

The displayed value is a height.

Used to select the measurement unit “milliradian”.

1 milliradian = 0.001 radian [rad is a unit of angular
measure equal to the angle subtended at the centre of a
circle by an arc equal in length to the radius of the circle
=180/n =57.3° (app.)]
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Used to select the measurement unit “microradian” =
1/1000 of a milliradian

Used to select measurement unit “degrees” up to 4

decimal places

Used to select measurement unit “degrees” up to 3

decimal places

Used to select the measurement unit “gon”.
1 gon =1/ 200 radian. Gon is also called grade or
new degree. Every new degree is divided into 100 new

minutes and every new minute into 100 new seconds

Used to select the measurement unit “millimetre /

metre”

Used to select the measurement unit “mils / inch”

Used to select the measurement unit “inch / 10 inches”

Used to select the measurement unit “degrees - minutes

- seconds”

Used to exit the “Unit” menu

17
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The “Unit” menu is exited by pressing [ with “exit” displayed. The next menu item
is accessed by pressing B to display the first menu item (Relative Meas), followed by
or [ repeatedly.

Memory
This menu item is used to save measurements taken.

= M 2mar l|_|.||- = This display shows that 12 of the available 999 memory
UEHQE' D].E {QE?} slots have data stored in them.

Pressing [ while in “Memory” reveals the submenu items. Use [ or [ to cycle
through the available submenu items.

M 2mor "_'."' Used when measurement data is to be stored manually
< manual =

To store measurement data manually, press with the submenu item “manual”
displayed. The selection of the data storage location is prompted as shown below.

Select Storage . .
The display indicates that measurements exist in storage
< S501=-used = | . ..

Use [= to cycle through the storage locations. INCLINEO saves up to 999 measure-
ments. Measurements may be stored in locations S 01 — S10. The data storage system
is such that any one location is able to store the maximum 999 measurements. As
the maximum number of measurements that may be stored in INCLINEO is 999, this
implies that it would therefore not be possible to store any other measurement in the
other storage locations.

Select Storage .
This display shows that presently, no measurements have
= 5 Uq’ = fl"E:E - been saved in storage location S 04.

After selecting the storage location to be used, press . The display as shown below
appears.

» -0.743

Fush HOLD to =sawve O0Y-000



INCLINEO handbook

Press [B (HOLD) to take and save the measurement or press i to exit.

After the measurement has taken place, the display below appears indicating that the
measurement has been saved in the selected storage location.

The 3 options available after measurement are “ok”, “retry” and “exit”. The required
option is selected using [ or [, then confirmed by pressing 2.

» When “ok” is selected and confirmed, the measurement is saved.

» When “retry” is selected and confirmed, measurement is repeated.

» When “exit” is selected and confirmed, measurement is abandoned.

The memory submenu item “auto” is used for the automatic recording and saving of
a definite number of measurements. The submenu item is accessed using [& or
while in “Memory”.

With “auto” displayed, press [. The selection of the data storage location is

prompted as shown below.

Use or 5 to cycle through the storage locations. Select measurement storage
location by pressing . This prompts the display of number of readings to be taken.

19
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The number of readings to be taken then saved is set using [B or . After setting
number of readings required, press . The duration for each measurement is then
prompted as shown below.

Sample Time
< 005 sec =

Set the duration for each measurement using [B or . Press [ to confirm setting the
duration. The following screen appears.

The bottom right corner of the display shows the
L = 0 o ? 4 3 currently selected storage location [04] and number of
Fush HOLD to save OY-000 measurements presently stored in the location [000].
Press B2 [HOLD] to start taking and saving set measurements.

This display shows the current storage location [05] and
L = 3 - 2 0 5 number of measurements already stored in the location
Auto Measuring... 03-016  [016]

If a storage location has previously been used, it is important to note the number
of measurements previously saved in the location, as new measurents are @
recorded successively. This is important when viewing saved measurements. In Note
the preceeding example, the next measurement will appear as number 017.

The taken and saved measurements may be displayed using the memory submenu item
“view" which is accessed as described at the beginning of this section (Memory).

Memory
L= view =

Press & with “view" displayed. The selection of the data storage location is prompted.
Use [& to select the location where measurements to be viewed have been saved.

Select Storage
< 504 =used =
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Press il to open the measurement storage location.

Use [ or [ to cycle through the saved measurements.

Backlight
This menu item is used to control the display backlight.

Pressing [ while in “Backlight” reveals the submenu items. Use [B or [ to cycle
through the available submenu items. Press i to confirm selection of the currently
displayed submenu item.

Used to switch the display backlight on

When selected, the backlight switches off

automatically after 30 seconds

When selected, the backlight switches off

automatically after 5 minutes

Used to switch the display backlight off

Used to exit the “Backlight” menu

The “Backlight” menu is exited by pressing fi& with “exit” displayed. The next menu
item is accessed by pressing  to display the first menu item (Relative Meas), followed

by B or B repeatedly.

21
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RF module

This menu item is used to turn wireless communication on or off.

Pressing 8 while in “RF Module” reveals the submenu items. Use [B or [ to cycle
through the available submenu items. Press il to confirm selection of the currently
displayed submenu item.

Used to establish wireless communication to a
PC. When selected the Bluetooth LED blinks

Used to turn wireless communication off

Used to exit the “RF Module” menu

The “RF Module” menu is exited by pressing [} with “exit” displayed. The next menu
item is accessed by pressing f to display the first menu item (Relative Meas), followed

by B or [ repeatedly.

The RF module complies with the conducted and radiated emission limits of FCC
rules part 15.247.

Device info
This menu item is used to display the device serial number, the firmware and hardware

versions.

Note
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With “Device Info” displayed, press [ to display the first device information. Use
or 5] to cycle through the available device information.

Device serial number is displayed

Firmware version is displayed

Hardware version is displayed

Used to exit the “Device Info” menu

23
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Measurement methods

Absolute measurement

This method is used to determine the exact or absolute inclination of the surface

being measured.

To carry out absolute inclination measurements, INCLINEO needs to be levelled. For

high precision, the measurement process demands that the object to be measured

and INCLINEO be at the same temperature. The surface where the level condition is to

be set must be relatively even and rigid.

1. Place INCLINEO on the object to be measured and switch it on. The active
measurement is displayed.

2. Set the displayed value as close to zero as possible. Use the rotating inclinometer
assembly and the micrometer screw.

3. Press i to access the menu, then press [B or B to select the menu item
"Absolute Meas".




INCLINEO handbook

. With “Absolute Meas” appearing on the display, press . The message
" 1. Angle Press ENTER to measure” appears on the display.
. Press [l to start measuring.

6. As soon as the measurement has stabilized, “ok” appears on the display below

the registered value.
Press [l to accept reading. The message “2. Angle Turn INCLINEO and press
ENTER to measure" appears on the display.

25
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8. With INCLINEO still in its original position, mark the current location to enable
INCLINEO be placed at exactly the same position for the reversal measurement.

9. Now rotate INCLINEO through 180°.

10. Align INCLINEO into place then press i to start second measurement.

11. After measurement has stabilized “ok” appears on the display. The system has
now been set for absolute measurements.

12. Press [ to confirm setting the level condition.

13. With the submenu item “save” displayed, press [iff to save the set-up. Readings
taken henceforth are absolute values.

For the second reading,
INCLINEO is rotated
through 180° and placed
at exactly the same
position as in the first

reading

INCLINEO'




INCLINEO handbook

Relative measurement

It may be necessary to know the relative inclination of different surfaces. This is carried
out using the relative measurement method.
1. Place INCLINEO on the selected reference surface and switch the system on.

It is recommended that the displayed value be set as close to zero as possible. a@)
You may use the rotating inclinometer assembly and the micrometer screw. Note
2. Press [If to access the menu items. “Relative Meas”appears on the display (if not

use [B or B to select it).

Press i to access the submenu items.

Use [ or [ to select “set zero".

Press ] to proceed to set the reference value.

o Uk W

After measurement, the collected value is displayed. Readings taken henceforth

are relative to the reference value.

27
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Measuring wide angles

It may be necessary to measure surface inclinations that are larger than the inclinometer
capacity of 10°. Such measurements are carried out using the relative measurement
method, and are made possible by the system’s rotatable inclinometer assembly.

If INCLINEO is placed on a surface with an inclination greater than 10° and turned on,
“overflow” is registered on the display.

The rotatable INCLINEO
housing allows high
precision measurements
on surfaces with steep

inclination.

In order to carry out relative measurements the rotatable assembly needs to be rotated

to display a near zero value.

1. To rotate the assembly, loosen it by rotating the locking lever anti-clockwise.

2. The assembly can now be freely rotated.

3. Use the micrometer adjustment screw to attain the near zero value. The nearer
to zero the higher the accuracy of measurement results.

i )

@ rorrechi

- 4 +0.0014
deghds

et
\ @m
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4. After attaining a near zero value, press i then use [B or [ to select “Relative
Meas".

5. Press [ to access the submenu items and use [E or [ to select “set zero”.
Press @ to confirm selection.

After set-up is completed, the inclinometer assembly must never be rotated. All ‘@)

related measurements must be taken using only this set-up. Note

7. Now proceed to carry out relative measurements.

In this configuration, the system can be used to measure the relative inclination of
surfaces with any inclination with an increased accuracy.

29
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INCLINEO ALIGNMENT CENTER PC software

Before using the INCLINEO ALIGNMENT CENTER PC software please familiarize

yourself with the ALIGNMENT CENTER PC software. Information relating to this G@)
software can be found in the ALIGNMENT CENTER File Manager and Flatness Note
manuals which are available from your local PRUFTECHNIK Alignment Systems
representative.

The INCLINEO ALIGNMENT CENTER PC software may be used to determine straight-
ness and flatness profiles of surfaces.

Creating a measurement file
1. After starting ALIGNMENT CENTER, select “File”>"New">"ALIGNMENT CENTER
flatness file".

g8 =T 5]
ek e wen Took b

i1 = @ Y
L j-’ﬁ

Sien | Db Last Mocifind

Obytes 01.07.2009 09:29

New Compary
o heba 0 byt 23102008 0903
Ingeet... . bt 9IKB 02.07.2008 11:13
Sotings New Area Bmbo Obyies 20.11.2009 16204
New Machine Train prribo 15,2 B 20.11.2000 17:28
ALIGNMENT CENTER. Bore alrement: fin
q ALIGNMENT CENTER Bors skgramme: tarpiate
Retornect [ sens
ALIGNMENT CENTER Flatness trmglotn H
B Fropertes +Ergabe ALTGNMENT CEMTER. Shalt skgrermed fe I-]
Ext ALIGNMENT CENTER Shaft slorment template
ALIGNHENT CENTER Straightness fie
ALIGNMENT CENTER Stasighirms berrplste
ALIGHMENT CENTER Tokrance fis
B
Tmswchireg fix cormercion... = | ][ 4
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2. Right-click the mouse with the cursor on the file name. Select “Rename” from
the pop-up menu that appears. Proceed to edit file name as appropriate.

B X E & Y
|

£ Local datatiase (corvecsa)

Local database
W Samphes
2 Tokrarces

07,07, 2009 13:31
01.07.2009 09.29|
23.11.2009 09:03]
23.11.2000 09:33
03.07.2009 11:13]
20,11,2008 16:04
20.11,2009 17:29|

1
i Flourids bad inclination
& Flouride bed ncination

|
=

Name: ALIGNMENT CENTER Flatness file (2)
Type: ALIGNMENT CENTER Flatness file
File Nama: EHTXCIT~.ACLavalign
Size: 0 bytes
Date Last Modified: Montag, 23. November 2003 09:33:17

3. Double-click the file name to open the file. The template assistant appears.

The template assistant will not appear if the file has already been configured. In c@

this case, the dimension screen will appear.
Note

31

Template assistant

Select type of measurement plane

@ Rectangle { Tracks

O circle | Ring

(JFile open
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4. Use the template assistant to configure file as necessary.

Note that the istance

Enter dimensions For the rectangular measurement plane between the columns

must be equivalent

Total width: Full length: to the Iength of the
Row interval: Distance columns: mounting base.

humber of rows: Humber of
columns:

[ <Back || Finish i[ Cancel ]

5. When file configuration is completed, click the “Finish” button. The dimension
screen showing the configured grid appears.

ABdH o e @=ne qu ol

Ll ] .,
ooy e
e =
—— =" wi
e el _L
meiics [ 3
e o
Tomint -
rmbe - I E.
b |
o win
|
— 1
P wan
5
= = —+—
g
[ 1900 e 1500 e 1808 e~ 1120 e 10 ~9fa— 100 —¥fe— 10 e~ 1R _j J_
" g

6. You are now ready to start taking measurements.

Taking measurements
1. Switch INCLINEO on and set the necessary measurement options as described in
previous chapters.
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» Measurements are taken wireless using the USB RF dongle ALl 13.620. See
schematic below.

» Alternatively use the cable combination which includes the receiver cable @
ALl 3.581-2 and the INCLINEO USB converter ALl 18.400. If using the cable Note
combination, please refer to the cable connection diagram below.

Standard procedure — USB RF

dongle schematic

USB RF dongle
ALl 13.620

INCLINEO computer port

Receiver cable ALl 3.581-2

INCLINEO USB converter
ALl 18.400

Alternative procedure - cable

connection schematic
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2. Click the ‘Measurement’ icon followed by the INCLINEQO icon on the button bar.
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3. Click the search button (3) located on the ‘Main sensor’ frame. The ‘Sensor

connection’ display appears.

Sensor connection ﬂ

r~ Blugkooth

FRUFTECHNI

i

Test

[

r—Serial

Search

K

b

On clicking the search
button marked (3)
above, the message
‘PRUFTECHNIK’ should
appear in the box
below ‘Bluetooth” as
shown opposite. This
indicates that the USB
RF dongle has been
detected.

4. Click the Bluetooth search button to scan the neighbourhood for INCLINEO

Bluetooth.

However, when using the cable combination, click the serial port search button.



INCLINEO handbook

5. If INCLINEO Bluetooth is detected, its serial number is displayed. If using the

cable combination, “PRUFTECHNIK - USB Port” will be displayed.

Sensor connection X Sensor connection

Bluetooth: INCLINED 73630127
C FKornmunikations: 155

Bluetooth

PRUFTECHKNI
Search
Test

Serial

Search

© ©
O

the cable combination has been used.

Blugtooth

FRUFTECHNI
Search
TESt

Serial
Search

QK
In example 5a, wireless communication via Bluetooth has been selected. In 5b Q@)

Note

6. Depending on method used, click either the displayed serial number or
“PRUFTECHNIK - USB Port” then the ‘OK’ button. This information is then

transferred to the ‘Main sensor’ information box.
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7. Complete Bluetooth/cable connection by clicking the ‘Connect’ button in the

‘Main sensor’ frame.

35



36

INCLINEO handbook
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8. Place INCLINEO on the grid marked on the surface to be measured. Place
INCLINEO so that the red tip of the handle points in the direction that measure-
ment will be carried out with the display in view. The direction of measurement
is clearly shown with the INCLINEO ALIGNMENT CENTER PC software.

The direction of
INCLINEO on the grid
may be changed using
a right mouse click.
Note: INCLINEO right
mouse direction
change is not recom-
mended and if at all
used, measurement
should be only in
absolute measurement

mode.
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9. With INCLINEO correctly placed on the location to be measured, click the corresponding
position on the INCLINEO ALIGNMENT CENTER measurement screen.

1500 e 1500 e 5010 e 1501 e 1500 e 1500 e 150 e 1500
1200 -

B

10. Allow the measurement to settle. This is indicated by the standard deviation value. As

soon as a stable value is attained, click the “Take point” button to take measurement.

The recorded value takes the two adjacent points within an axis into consideration.

11. Repeat steps 8 through to 10 for all necessary measurement points progressing through

the grid in the specified direction.

The taken measure-
ment points appear

in grey.

1 M CINTES, ree
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Evaluating results

After measurement has been completed, click the ‘Results’ icon to evaluate the results.
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To be able to interpret measurement results, any one single measurement point within
the grid has to be assigned a specific value. This arbitrary value is used to convert the
angles measured into a height measurement. To enter the value, proceed as follows.
1. Right-click the chosen measurement point. A pop-up menu appears.
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2. Click the menu item ‘Manual measurement’. Enter the arbitrary value in the
value box marked Y. This value could be the actual height/depth of the selected
measurement point.
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The reference value

of 0.3 is entered at

point B1.

After the arbitrary value has been entered (2) above, the results may be displayed in

2D and 3D formats.
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Using a Bluetooth-enabled PC for INCLINEO connectivity

PRUFTECHNIK Alignment Systems recommends use of the USB RF dongle
ALl 13.620 for Bluetooth connectivity between a PC and INCLINEO. If using a PC
with Bluetooth capabilities, the PC Bluetooth Manager is used to acquire wireless

connectivity.

In such instances, the ‘Authentification Request’ window will appear. Enter the

pin code “blue”. @

Note

Bluetooth Manager - Bluetooth-Sicherheit

BlutoothSchiiissel (FINE |
ﬁ [Falls das Feld leer bleibt, wird die Standard-PIN venwendet. ]

Gerat anfordern
Blustooth-Gerdteadresse:  00:17:91:03:11:95
Bluetoath-Geratename: INCLINED 73630143

Abbrachen |
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Appendix to INCLINEO ALIGNMENT CENTER software

This appendix provides information about certain aspects of the PC software that
may not be regularly applied but may prove useful to the user.

Default measurement screen
The screen below shows the default configuration of the measurement screen when

the INCLINEO function is selected.
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I Zveeage

Vo]

Bty ' = || et cener

In the default configuration, the ‘Measurement’ and ‘Memory’ panes overlap. The
panes may be positioned at any selected location by clicking the appropriate tab and
holding the mouse down. The panes may be docked at the positions that turn light
blue when the cursor goes over the respective docking guide.

=

Note
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In this example, the
‘Memory’ pane can
be dragged to the
location highlighted
light blue and docked
by releasing the

mouse button.

All measurements
stored in INCLINEO
are displayed in the
‘Memory’ pane. In
this example, the first
measurement value
stored is storage
location 1 is diplayed
in the 'Angle” box.
The value stored was
0.001°.

The memory pane is used to display all measurements that have been stored in

INCLINEO. To display the readings, follow steps 1-7 as described in ‘Taking measure-

ments’ starting on page 31. However use only the buttons on the ‘Memory’ pane.

When connection is established, the message “Successfully connected” appears in

the ‘Angle’ box.
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The auto-routing function enables the intelligent and automatic selection of the next meas-
urement point. Auto-routing can be activated at anytime. To activate auto-routing select

‘Tools'>'Options'>'Auto-routing’.

Chooss a categorie

Bl

Units
o
D
Resul
INCLINEO measurement
INCLIMEO measurement
-~ Auta routing

El Repart

Header and footer

- Content
Language

- Style

Auto routing

Automatic fl

Ise

[ Activate automatic Fiow
% Constant direction
" Alternating direction

Direction

[Lower left ko upper right

Loweer right ko Upper left
Upper left ta lawer right
Upper right ta lower left

=1

Cancel |

Apply

The ‘Direction’ drop
down menu shows
the available turn-by-

turn directions.

Auto-routing is activated by checking the ‘Activate automatic flow’ box, and can be further
defined in terms of the turn-by-turn directions.

Al

A2

A3

A4

B1

B2

B3

B4

» Constant direction implies that measurement will always be taken in the same direction:
Al —> A2 —> A3 —> A4 —>B1 —>B2—>B3 —> B4

» Alternating direction implies that measurement direction can be changed:
Al —> A2 —> A3 —> A4 —> B4 —>B3 —> B2 —> B1
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INCLINEO technical data

INCLINEO high precision inclinometer ALI 18.201

Measurement range
Resolution

Limits of error at
calibration [Ta =22°C]
Limits of error at
measurement [Ta =22°C]
8-hour zero-point drift
Digital Filter/Average
Temperature range

Display

User interface

Wireless communication
External interface

Power supply

Battery status indicator
Data storage
Integrated RF module

USB RF dongle ALI 13.620
PC interface
Temperature range
Dimensions
Antenna
Transmission power
Details

+10°

0.0003°[1"]

0.005% full scale

0.03% read out

0.005% full scale

0.06% read out

0.04% full scale

3rd order with 0.3/ 1/ 3 Hz options

Storage: -40°C to 85°C

Operation: -10°C to 60°C

LCD display, 132 x 32 pixel with LED backlight

Three key operation

Embedded RF module with LED indicator

RS-232 (serial) for computer and sensor

Connector for dial gauge

2 AA batteries

3 LEDs

Up to 999 measurements

Antenna — integrated

Transmission power — 20 dB max.

Complies with part 15 of the FCC rules. Operation is subject to following
conditions:

- Device must not cause harmful interference

- Device must accept any interference received, including interference
that may cause undesired operation

This transmitter is considered as mobile device and should not be used
closer than 20 cm from a human body.

Contained transmitter module — FCC ID: POOWML-C40 / CE: CE0678(D

USB 2.0 compatible
-40° C to 85° C
68 x25x 13 mm
Integrated
19 dBm
Complies with part 15 of the FCC rules. Operation is subject to following
conditions:
- Device must not cause harmful interference
- Device must accept any interference received, including interference
that may cause undesired operation
This transmitter is considered as mobile device and should not be used
closer than 20 cm from a human body.
Contained transmitter module — FCC ID: QOQWT41 /
IC: 5123A-BGTWT41
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Symbole

00621 0038
Philips cross
screwdriver 7
00739 1056
allen key (3.0 mm) 7
90022
AA-size battery 7

A

Absolute inclination 24
Absolute measurement 15, 24
ALl 3.581-2 8

receiver cable 33
ALI9.182.G 7
ALI9.183.G 7
ALl 13.620

USB RF dongle 6
ALl 13.700 CD

ALIGNMENT CENTER CD 7
ALl 18.000

INCLINEO standard package 6
ALl 18.200 6
ALl 18.201 6
ALl 18.400

INCLINEO USB converter 33
ALl 18.500 6
ALl 18.500-M

magnetic foot 8
ALl 18.501-150

grooved mounting base 6
ALl 18.502-150

prism-shaped mounting base 6
ALl 18.800 7
ALIGNMENT CENTER PC 30
Auto-routing 43
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B

Backlight 21
Batteries

replacing 13
Battery

compartment 13
Battery compartment 12
Battery status LED indicator 12
Bluetooth-enabled PC 40
Bluetooth LED indicator 12

C

Calibration accuracy 10

Calibration certificate
ALl 18.290 8

CE compliance 9

D

Data storage
hint 10
location 19

Default measurement screen
PC software 41

Device info 22

E

Evaluating results 38
External interfaces 12

F

FCC rules
part 15.247 22
Filter 15
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H
Handle 12

INCLINEO connectivity
Bluetooth 40
INCLINEO package
grooved mounting base
ALl 18.001 8
prism-shaped mounting base
ALl 18.002 8
three-point mounting base
ALl 18.003 8
INCLINEO USB converter
ALl 18.400 8
IP classification 9

L

Labelling 10
Locking lever 13

M

Measurement base 12
Measurement units 16
Memory 18

Memory pane 42

Micrometer adjustment screw 28

Micrometer screw gauge 12

0]
Operating keys 12

P

Pane
overlap 41
Pin code 40
Power
AA size alkaline batteries 13

R

Receiver cable

ALl 3.581-2 8
Relative base length 16
Relative measurement 14, 27
RF module 22

Rotatable inclinometer assembly 12

S

Safety symbols 9
Storage 10

Storage location 20
Storage locations 18

T

Technical data 44
Template assistant 31

U

Unit

arcsecond 16
degrees 17
gon 17
milliradian 16
USB RF dongle
ALl 13.620 33

W

Wide angles
measuring 28
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